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IMiN Communicator

1.1

Introduction

Introduction to IMIN Communicator

IMiN Communicator is corporate grade Instant Messaging and Presence Awareness Software.

Communicator's presence awareness features lets you see who is currently online before you send a
message. Users can not only send messages to one another using Communicator, they can also send
and receive email, SMS, and pager messages.

Communicator is fully customizable, allowing individual users to create their own one-touch responses
and other functions. This allows you to deal with many messages with a single keystroke. You can
create a Favorite list for people who you communicate with frequently and create customized groups
that you can keep private, or share with other IMiN users.

Communicator does not tie you to a single location. It can be setup on your home and work computer
or your laptop. Your customized settings and Archived messages are stored on a central server to
provide you with the same "look and feel" wherever you are.

www.rbza.com
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Introduction 3

Communicator Interface Overview

The following is a general overview of the Communicator interface.

g h i i k | m

© IMiN Communicator - .JD Kobayashi
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Figure 1A

a. User Tree — The User Tree lists all of the users you can send messages to.

For more information, see Understanding User Tree.

b. Recipient Window — Shows where the message/reply will be sent.
c. Outgoing Message Window — Messages/replies are typed here.

d. Sender Window — Shows who sent the message. Also displays the location and application from
which the message was sent.

e. Incoming Message Window — Messages received are displayed here.
f. Fast Keys — Fast Keys are "one-touch" response keys that eliminate the need to type a reply.

For more information, see Replying To A Message.

g. Send Button — Sends the message/reply.

© 2005 - R.B.Zack & Associates, Inc.



IMiN Communicator

h. Clear Button — Clears the contents of the Recipient, Sender, Incoming and Outgoing Message
windows.

i. History Button — The History allows you to view and print any messages you sent or received.
For more information, see History.

j- Find Users Button — The Find Users feature allows you to search for any user in any Zone.
For more information, see Find Users.

k. Tools Button — The Tools button accesses the Communicator Preferences.

I. AutoReply Button — The AutoReply feature allows you to automatically send a predetermined reply
to anyone who sends you a message

For more information, see AutoReply.
m. Close Button — Minimizes the Communicator interface to the system tray.

n. Status Area — Displays status messages when certain activities take place. For example, when a
message is successfully sent, the status message will say "Delivery Successful”.

0. Character Counter — Displays the number of characters in the Outgoing Message window.
p. Unread Message Counter — Displays the number of unread messages.
g. AutoReply On/Off Indicator — Indicates whether AutoReply is on or off.

r. Time — Displays the time.

© 2005 - R.B.Zack & Associates, Inc.



IMiN Communicator 5

2 IMIN Communicator

2.1  Starting IMiN Communicator

Communicator works together with another program called EBS Proxy. The Proxy logs you into the
IMiIN network and provides you with a secure connection. Communicator is the program you use to
actually communicate with other users.

To start Communicator:

1. Go to Start > All Programs > IMiN > Communicator > Communicator. See figure 2a.

F-_; IMiM ri Cormunicator  k ' Carnrmunicatar
InkerVideo WinDYD 4 » [l ) EBS Proxy 2 Delete Local History Cache

T Gicken ' E
Datarnate p| < =) Delete Local Preferences Cache

- rﬁ irk Tirme ¥ AR Tnrelifawer Teme
Figure 2a

2. The Proxy will start automatically and bring up the EBS Log On screen. Enter the Login name and
Password provided by your network administrator. Select a Location. Click "OK". See figure 2b.

Log On to EBS x|

Enterprise Business Services
A cosplete comintanicgtipns platorin

Datamate Global Communications Inc. @ 2004

Logik narme: ﬂ
EaSSWD[d REXNNNRERE
Location | Desk [wiark) ﬂ

v H ber P d
Bemember Pazswar oK Cancel |

| Login Automatically

Figure 2b
Checking "Remember Password" will eliminate the need to enter your password each time you log in.
Checking "Login Automatically” will allow you to bypass the EBS Log On screen altogether.

3. When the Proxy connects, a satellite dish icon with a green check mark over it will appear in the
system tray.

© 2005 - R.B.Zack & Associates, Inc.
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E

If the Proxy cannot connect, the satellite dish icon will appear with a red "x" over it.
Contact your network administrator.

4. Once the Proxy connects, Communicator will start up. An hourglass icon will spin in the system tray
while Communicator is attempting to connect. When Communicator connects, a blue dialog bubble
icon will appear replacing the Proxy icon.

If Communicator cannot connect, the hourglass will continue to spin over the dialog bubble icon. If this
persists, contact your network administrator.
Auto Start

Communicator can be configured to start automatically whenever the computer is turned on or
rebooted. To do this:

1. Check "Login Automatically" on the EBS Log On screen. This will automatically check the
"Remember Password" box. See figure 2c.

Figure 2c

2. In Communicator, go to Tools > General. In the General section, check the Auto Start box. See
figure 2d.

General l Delivery & Status MNotific

General
[ Always on Top [z
[v Start Minimized [v ¢

Figure 2d

The next time your computer is re-started, Communicator will Auto Start.

© 2005 - R.B.Zack & Associates, Inc.



IMiN Communicator 7

2.2  Displaying/Hiding The Communicator Window

Once started, Communicator continues to run in the background even when the Communicator
window is not displayed on the screen. This allows you to work normally without having to keep the
program open all the time.

To indicate that Communicator is running, a blue icon is continuously displayed in the system tray in
the bottom right-hand corner of the computer screen.

=)
To display the Communicator window:
1. Click once on the Communicator icon in the system tray. Or...
2. Ctrl + Shift + Up Arrow

This keyboard shortcut can be customized.

See Communicator Preferences > General > One Touch Maximize

To hide the Communicator window:

1. Click on the Communicator icon in the system tray again. Or...
2. Click the "Close" button on the tool bar. Or...

3. Click "Minimize" or "Close" on the Communicator window. Or...
4. File > Hide. Or...

4. ESC key.

© 2005 - R.B.Zack & Associates, Inc.
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2.3

Understanding the User Tree
The User Tree lists all the users and entities that you can send messages to.

Favorites, My Zone, My Site and Groups

The User Tree has four main areas; "Favorites”, "My Zone", "My Site" and "Groups".
See figure 4a.

= Favorites

Oy My Zone [DataM ate]

- 5# My Site [DataMate EBSB
iy Groups

[ [

Figure 4a

1. Favorites

Favorites is an area where you can create a custom list of the recipients you send messages to most
often. See figure 4b.

-I-Z  Favorites ~
-0 Johin Savage

—-C 4 Desk
042 Commuricatal
- i) EchoServer

—|- 49 Laptop
! Commuricatal
21 Emnail
0 g SHSPager

=0 Mike VandemoretDes
Figure 4b

For more information, see Add To Favorites.
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2. My Zone

A zone is a list of users. My Zone is simply a list of all the users in your particular zone.
See figure 4c.

+-2  Favorites b
-0y My Zone [DataM ate)
BB &
+ - o Bob Bakos
+ - o Brandon Worthingtan
| s Brian Petersan
= B Desk
) Commuricatol
) Email
g SMSPager
Figure 4c

The users included in My Zone can vary depending on how your network administrator organizes your
IMiN network. Typically, My Zone would include all of the users within your company. Other zones
appearing in the User Tree could be, for example, other organizations that your company needs to
communicate with.

My Zone could also represent all the users in your department. In this case, the other zones could be
other departments within your company.

3. My Site

My Site contains every zone including your zone. See figure 4d.

+-Z°  Favorites -
+- 0O My Zone [DataM ate]

= 5% My Site [DataMate EB
s AT Capital

O Ares

O Baseling Data System
O Columbus Neva

O Copytype

O CueTech

O Databate

Figure 4d

O O [ B
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4. Groups

A group is a customized list of recipients. See figure 4e.

=~ Favontes
0y My Zone [DataMate)
-3 My Site [DataMate EBSE
-y Groups

+- O DM [Public]

+- O NoHo [Public]

+

+

+

Figure 4e

You can create your own groups which can only be seen by you (Private Groups). Your network
administrator can create groups which can be seen by everyone (Public Groups).

For more information, see Groups

Locations and Applications

You can have more than one location where you can send and receive messages. In most cases,
your primary location will be "Desk". However, if you sometimes work from home, you could also have

"Home" listed as a location.

In this example, Tim Martin has four locations; "ConfRoom", "Desk", "Home" and "Laptop".
See figure 4f.

=iy Tirn Martin L

= &0 ConfRoam

! Commuricatar
—-CE0 Desk

DL Commuricatar

D1 Emnail

0 d SMSPager
—-CEd Home

DL Commuricatar
—|-- &1 Laptop

~ el Commuricaton s

£ *

Figure 4f

Communicator is the primary application used to send and receive messages. Usually, messages are
sent from one Communicator user to another. However, Communicator can also be used to send
messages to email and to cell phones and pagers.

In this example, Tim Martin has "Communicator” listed as an application at all four locations. However,
at his "Desk" location, he also has "Email" and "SMSPager". See figure 4f.

Note: Email and SMSPager are optional features. Check with your network administrator to see
whether they are available at your organization.

© 2005 - R.B.Zack & Associates, Inc.
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Expand/Collapse View
The view of the User Tree can be expanded or collapsed.

To expand the view, right click on the area (Favorites, My Zone, My Sites or Groups) or user you wish
to expand and select "Expand all Children". See figure 4g.

|T OITSNGE;

] Favontes ‘

o LAEMy Zone [Torrance

+44 My Site (RBZA)
+ iy Groups Expand all Children

Add to Favorites

Figure 4g

To collapse the view, right click on the area or user you wish to collapse and select "Collapse all
Children". See figure 4h.

|T|:-rran|:E'

2 Favorites -
-0
@4 Alex Agustin Add to Favarites
+-- @&l Desk L
--® 5% Ann Holmberg

|

Collapse all Children

Figure 4h

Note: Clicking "+" or "-" also expands or collapses the view.

© 2005 - R.B.Zack & Associates, Inc.
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2.4

Sending A Message
There are three steps involved in sending a message to another user:

1. Choose where the message will be sent

There are two ways to choose where the message will be sent:

a. Recipient Window

Begin typing the name of the person into the Recipient Window. The window will display a list of
available recipients matching the first two letters of the name you typed in.

The recipient may be available at a location other than the "Desk" (i.e. "Home") and/or on an
application other than "Communicator” (i.e. "Email", "SMSPager"). A message may be sent to any of
the users\locations\applications listed. See figure 5a.

Tim Martin\DeskASMS Pager
Tirm MartinHome

Search Site. .
! Communicatar
= 0 Desk
- Communicatar
Figure 5a

Note: Selecting "Search Site" from the list will allow searches for recipients in other zones.

For more information, see Find Users.

b. User Tree

Select the recipient from the User Tree by clicking on the desired user\location\application. More than
one recipient may be selected. The message will be sent to all selected recipients if available.

The User Tree uses icons to identify the availability of the recipient.

‘¥ Communicator is online. Message can be sent.

E-?I”': Communicator is in AutoReply mode. Message can be sent.
2: Communicator is in Not at Desk mode. Message can be sent.
&' Communicator is offline. Message cannot be sent.

Note: Messages can be sent to Email and SMSPager at any time. The recipient is always considered
available on both of these applications.

© 2005 - R.B.Zack & Associates, Inc.
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Example 1: Selecting a recipient from the User Tree

Selecting the recipient "Tim Martin" will send a message to each of the locations and applications
where Tim Martin is available. In this case, the locations\applications are "Home\Communicator" and
"Laptop\Communicator". The selection is indicated in green next to the name. Available
locations\applications listed below the selection are indicated in purple. See figure 5b.

|Tim M artin; |
—-CE Desk A
L) Carmmunicatar
--@ 5 Tim Martin
—|--- B0 ConfRoom
gt Carmmnicatar
28 Desk
gt Carmmnicatar
21 Email
0 SMSPager
—|- @& Home
&2 Cormmnicatar
—|- @& Laptop
. Cormmnicatar

Figure 5b

Note: Selecting a recipient will not automatically send a message to their Email or SMSPager. Each of
these must be specifically selected.

Example 2: Selecting a specific application from the User Tree

Selecting the application "Communicator” at the location "Laptop" for "Tim Martin" will only send the
message to Tim Martin at his laptop. Again, the selection is indicated in green. "Laptop" is indicated in
solid blue. This means that every available application listed below "Laptop" has been selected. The
half blue indicator next to "Tim Martin" means that only some of the available applications listed below
"Tim Martin" have been selected. See figure 5c.

|T irm b artinL aptop;

—-CEd Desk ~
D02 Communicatar

—| i@ gy Tirn Martin

= &0 ConfRoamn

- Communicatar
B9 Desk

- Communicatar

21 Emnail

0 SHSPager
28 Home

D2 Commuricatan
&0 Laptop

@2 Communicatar

Figure 5c
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A message can be sent to a group of recipients. For example, selecting My Zone will send a message
to all available recipients in your zone.

Messages can also be sent to Favorites, groups listed under Groups and zones listed under My Site.
Messages may be sent to My Site if administrative permission is granted.

Multiple zones and groups may be selected.

2. Type the message

Type the message in the outgoing message window. If the cursor is not already in the outgoing
message window, click once inside the window.

File Edit Help
ZfSend = Clear @ﬂistury 3¥oFindUsers  #:Tooks & Autoreply
Steve Bochman; Tirn b artin iz an line 1|

- Communicator &
—-Z 8 Desk
22 Comrmunicator
|- @5 Steve Bochman
—- @& Desk
@7 Comrmunicator

Pad? RPN

Figure 5d

Clickable hyperlinks and email addresses can be included in the message. Text can be colored,
formatted and edited by right clicking inside the outgoing message window then selecting the desired
option from the panel.

3. Send the message

Click "Send" to send the message. Alt+S or Ctrl+Enter will also send the message. By default,
Communicator will close on send.

© 2005 - R.B.Zack & Associates, Inc.
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2.5 Receiving A Message

When a message is received, Communicator notifies you with a pop-up window and an audible alert
(both are default settings which can be changed). The Communicator icon in the system tray toggles
back and forth between a single and double icon.

ef%

The message received is displayed on the screen in the incoming message window. The name of the
sender and the location/application from which the message was sent are shown in the sender
window just above. See figure 6a.

|J.D. k.obavazhitDesk \Communicator ﬂ ﬂ

Timn M artin iz on line 1

Figure 6a
You can change the way Communicator notifies you when a message is received.

See Communicator Preferences > General > Message Notifications and
Communicator Preferences > Audio

Receiving Multiple Messages

There will be times when you receive more than one message within a short duration. When that
happens, all subsequent messages stack up behind the first message in the order in which they are
received.

Communicator notifies you with an audible alert each time a subsequent message is received. This
alert sound will be different from the first message received alert.

The message counter in the status bar shows the number of unread messages. See figure 6b.

Chars: O nread: 2 AutoReply OFf |2:25:24 P4 .

Figure 6b

The first message will remain on the screen until you either reply to it or scroll to the next message.
After you respond to the first message, the next message in line will be displayed. When the last
message is either read or responded to, the unread message counter will read "0".

Note: A message is considered "read" by Communicator when you (a) reply to it (b) scroll to the next
message or (c¢) close the Communicator window.

© 2005 - R.B.Zack & Associates, Inc.



16

IMiN Communicator

2.6

Replying To A Message
There are two ways you can reply to a message:

1. Type the reply

When a message is received, you can begin typing your reply immediately. The cursor will already be
in the outgoing message window and the sender's name will be listed as the recipient. Click "Send"
when finished typing. The Communicator screen will close automatically.

2. Fast Keys

Fast Keys are "one-touch" response keys that eliminate the need to type a reply. The default Fast Key
message set is shown below in figure 7a.

- Ves | - Mo | | Take Mg | wl Wil Cal | | Put Thiu | w|  Hold |
| Call Back | m|  UHandle | ral  Sendin ||:1u About? |m Ok |;12 Lunich? |
Feady Chars: 0 Unread: 0 AutoReply OF 11:02:26 Ak
Figure 7a

You can either click the desired Fast Key or press the corresponding function key. There is no need to
click the "Send" button. The reply is sent and the Communicator screen closes all in one action.

There are two Fast Key message sets; the "Primary Set", which is the one displayed, and the "Control
Set". The Control Set can be displayed by holding down the control key. To use any of the Fast Keys
on the Control Set, hold down the control key while selecting the desired Fast Key.

Note: This example uses a Communicator skin with 12 Fast Keys. The number of Fast Keys displayed
depends on the skin selected. Skins with 18 and 24 Fast Keys are also available.

Each message set contains 12 Fast Keys all of which can be customized.

See Communicator Preferences > Fast Keys

© 2005 - R.B.Zack & Associates, Inc.
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2.7 Browsing Messages

You can scroll through your incoming messages by using the right/left browse buttons located to the
right of the sender window. See figure 8a.

|Tim b artinh D ek SCormmunicatar ﬂ j
Figure 8a

Clicking the right arrow button advances to the next message. Clicking the left arrow moves back to
the previous message.

The keyboard shortcuts are Alt + Right Arrow and Alt + Left Arrow.

© 2005 - R.B.Zack & Associates, Inc.
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2.8

AutoReply

The AutoReply feature allows you to automatically send a predetermined reply to anyone who sends

you a message.

For example, if you're in a meeting and cannot respond to incoming messages, you can select "l am in
a meeting" as your AutoReply. Anyone sending you a message will automatically receive that

message back.

To turn on AutoReply:

1. Click on the AutoReply button located on the tool bar of the Communicator window. See figure 9a.

b Autareply

Figure 9a

2. The AutoReply window will appear. See figure 9b.

© Communicator - AutoReply

This message will be sent as a reply to incoming
messages when the "AutoReply" Feature is turned on,

Remove | Ok | Cancel

Figure 9b

3. Select an AutoReply from the drop-down menu. See figure 9c.

© Communicator - AutoReply

This message will be sent as a reply to incaoming
messages when the "AutoReply" Feature is turned on,

I am currently unavailable, -

I am currently unavailable.

I am in a meeting.

I am ot Far lunch,

I am ook For coffes,

I will be back in 5 minutes,

I am ok the resk of the day
Add MNew Autq@ﬁgl}r.‘.'.ﬂ _

Figure 9c

...or add a new AutoReply. Click "OK". See figure 9d.

© 2005 - R.B.Zack & Associates, Inc.
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© Add New AutoReply Message El

Please enter wour new AutoReply message,
| I'l be back at 3PM|

Ik, | Cancel |

Figure 9d

4. The Communicator screen will close automatically. AutoReply is now turned on.

When AutoReply is turned on, the button on the tool bar will appear indented (Figure 9¢e). Your
Communicator icon will appear with an arrow over the top of it (Figure 9f).

B Autoreply

Figure 9e
&
Figure of

5. When someone sends you a message, they will receive your AutoReply message. See figure 9g.

|J ohn 5 avagehDesk \Communicatar

| am curently unavailable.

From: J.D. Kobayazhi @ 512:01 P [5/11/2008]
To: John Savage
Meszzage: Are pou there?

Figure 99

They will also receive an AutoReply Notification. If the sender clicks "Yes" to the notification, an Online
Notification Watch will be placed on you. They will automatically be informed when you turn off
AutoReply. See figure 9h.

© Communicator - AutoReply Notification

_~ John Savage is in AutoReply mode,
4') Do wou wish to be notified when they turn ofF AukoReply?

[ Remember ry selection Tes

Figure 9h

Note: Messages you receive while AutoReply is turned on are treated like any other messages and
are available to read whenever you want.

To turn off AutoReply

© 2005 - R.B.Zack & Associates, Inc.



20 IMiN Communicator

Open the Communicator screen and click the AutoReply button again.

The feature can also be turned off by right clicking on the Communicator icon and then left clicking the
AutoReply option in the panel. See figure 9i.

Show

v AutoReply
Preferences., .,

Ezxit

Figure 9i
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2.9 Find Users
The Find Users feature allows you to search for any user in any zone.

To find a user:

1. Click the Find Users button located on the tool bar of the Communicator window. See figure 10a.

532 Eind Users

Figure 10a

2. The User Search window will appear. Begin typing the user's name in the search window. The
window below will list any matches. Select the desired user and click "OK". See figure 10b.

%* User Search ['5—<|

| ste| |5tarts with ﬂ Search...

stephen Bradford
Skeve Bochman
Skeve Halder

3 matches
Ok Cancel

Figure 10b

Note: Searches may be done on any part of the user's name. Select the search option from the pull-
down menu next to the "Search" button. Options include "Starts with", "Contains", "Ends with" and
"Exact".

3. The selected user is automatically added to Favorites. If the user is online, their name is placed in
the recipient window. If the user is not online, you will receive a message saying that the user has
been added to Favorites but is currently offline and cannot be selected now. See figure 10c.

IStephen Bradford\Desk;

--@  Favorites
--® 5 Stephen Bradford
=] B AICEQueue Server
=) Carmmunicator
—|- @] Desk _3
@2 Communicator

[

Figure 10c
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2.10

History

The History allows you to view and print any messages you sent or received.

To open the History window:

Click on the History button located on the tool bar of the Communicator window. See figure 11a.

@ Histary

Figure 11a

The History Window

The History window contains six columns. See figure 11b.
a b c d e f

listory - 15 Messages

Locatioh | uisis)iee=E)] Direckion |Sent and Receiven j Time |This ek, j
1 1 ] ] 1
SiR | Lo, | Time {Dake) | Fraom | To | Message -

=0 Desk  5:43:15 AM(5/10/2005)  Tim Marbin\CeskiCao... D Eobayashil... Yes

=0 Desk  &:43:11 AM(S/10/2005) 1D KobavashitComm...  Tim MartiniDe...  How about yours?
=0 Desk  $:42:52 AM(5/10/2005)  Tim MarkinlDeskiCo...  JD Kobayashil...  Your place or mine?
40 Desk  5:42:43 AM(5/10/2005) 1D KobayashilCornm,.,  Tim MarkiniDe... et me know when you

Figure 11b

a. S/R (Sent/Received) — Blue left arrow icon indicates a "sent" message. Red right arrow indicates a
"received" message.

b. Loc. (Location) — The location you are logged in at when you sent or received the message.

c. Time (Date) — The time/date that the message was sent or received.

d. From — The sender.

e. To — The recipient.

f. Message — Message content.

Each column can be sorted in ascending or descending order by clicking on the column heading. For
example, clicking on the Time (Date) heading will sort the messages so that the oldest messages are

displayed first and the newest last. Clicking it again will display the newest first and oldest last.

Note: The History title bar displays the number of messages in the message list.
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The Message History Filters

There are five message filters that allow you to determine which messages appear in the list.
See figure 11c.

© History - 15 Messages

File:
Location |iglE el Direckion |Sent and Received ﬂ Time |This Week ﬂ
Keywiord -I-— d e _..,
SiR | Lo, | Time (Dake) | From | To | Message -

=2  Desk  5:43:15 AM(5/10/2005)  Tim Marbin\CeskiCao... D kKobayashil... Yes

=0  Desk  &:43:11 AM(S/10/2005) 1D KobavashitComm...  Tim MarkiniDe...  How about yours?
=0 Desk  §:42:52 AM (S/10/2005)  Tim Martin\CeskiCo...  JD Kobayashil...  ‘Your place or mine?
=0 Desk $:42:43 AM(5/10/2005) 1D KobavashitCorm,..  Tim MarkiniDe... leb me know when you

Figure 11c

a. Location - The location of the user. Messages can be viewed either by "This location" or "All
locations". "This location" will list messages sent/received at the user's present location. "All locations"
will list messages from any location where the user has had Communicator running.

b. Direction — The user can view "Sent" messages only, "Received" messages only or both "Sent and
Received" messages.

c. Time — The user can specify the time frame of the messages to be displayed. Choices include
"Today", "Yesterday", "This Week", "Last Week", "This Month", "Last Month" or "Anytime".

d. Keyword - Messages can be listed based upon a keyword search of the message content.

e. Search Button — Click the Search Button after filter selections are made.

Creating a Custom Message View

To create a custom message view, select the desired search option from each of the three pull-down
menus. Enter a keyword if needed.

For example, to view all messages sent last week containing the word "order":

1. Select "All locations" under Location, "Sent" under Direction, "Last Week" under Time and enter
"order" in the Keyword window.

2. Click the Search button.
3. All messages matching the selected criteria — if found — will now appear in the list.
Note: When the History window is closed, the view will return to the default setting of

Location > "This location", Direction > "Sent and Received", Time > "This Week" and
Keyword = blank.
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Printing

The History has a print option that allows you to print individual messages, selected messages or all
messages. See figure 11d.

To print individual or selected messages, highlight the message(s) to be printed then go to File >
"Print Selection".

To print all messages within the active view, go to File > "Print All".

© History - 99 Messages

Yiew Canversation —

Print Al
Print Seleckion

Exit
|40 Desk 11:36:51 am(5pe
Figure 11d

Conversation View

The Conversation View displays the entire conversation associated with any message. Select a
message from the list then double-click on it to display the conversation. See figure 11e.

The "Next" and "Previous" buttons bring up the next/previous message conversation.
The "Print" button allows the conversation to be printed.

P Conversation View - 2 Messages @

Fromy: 1D Kobayash\Communicator @ 11:33:00 aM (5]6/2005)

Toe Jeff JacksonDesky Communicabor

Message: ok = o
From: Jeff lackson\DeskiCommunicator @ 1 1:32:40 AM (582005}

To: 10 Kobayashi ll {siel Dielivery Bepart

Message: I'mrebooting NTE, the exchange server. NT11 s the file server... =
vt ..

Close

Figure 11e
Note: The Conversation View title bar displays the number of messages in the conversation.

The Delivery Report shows whether the message delivery was successful.
Click the "Delivery Report" button to display the report. See figure 11f.
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® Delivery Report [z|
Deelivery partialy succesdad (12 of 27), A
L: Torrance,

1: Tirm Martn)LapboptCommunicator Faled. (The destination is offiine so cannot receie this
message. [RC_DESTIMATION_IS_OFFLINE])

2: Boyd ZackiDeskiComemunicabor succeeded.

3 Jeffrey Jackson\DeskiCommunicabor succeeded,

4: Tim MartiniDeskiComemunicabor Failed, (The destination is offline so cannot receive this message.
[RC_DESTINATION_IS_OFFLINE])

S Yewgeny Chan\DeskiCommunicebor Failed, (The destination is offfine so cannot receie this
message. [RC_DESTINATION IS OFFLINE])

&z Unknoven AppCient Faled, (The destination is offine so cannok receive this message, -

R et IRt L B Y

Figure 11f

The Delivery Report is most useful when sending a message to a group. The report will tell you who
received the message and who did not.

Deleting Messages

Messages cannot be deleted.
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2.11 Not At Desk Mode

The Not At Desk mode is used to automatically notify others whenever you are logged into
Communicator but have been away from your computer for a period of time. By default, this period is
15 minutes.

When Not At Desk mode is active, your Communicator icon will appear with a white note over it.
P

When someone sends you a message, they will receive your Not At Desk message. See figure 12a.

|-J ohn SavagetDezkhCommunicator

Sormy, | am not at my desk right now.

From: 1.0 Kobayazhi @ 25227 P [5/11/2005)
To: John Savage
Message: Are you there?

Figure 12a

They will also receive a Not At Desk Notification. If the sender clicks "Yes" to the notification, an
Online Notification Watch will be placed on you. They will automatically be informed when you return
to your desk. See figure 12b.

© Communicator - Not At Desk Motification @

John Savage is not at their desk.
__,J Do wiou wish bo be notified when they return?
L]

| Remember my selection

Figure 12b

Not At Desk mode is de-activated when you return to your computer and either move the mouse or
touch the keyboard. Your Communicator icon will now appear without the white note over it.

Note: Messages you receive while in Not At Desk mode are treated like any other messages and are
available to read whenever you want.

The Not At Desk mode message and inactivity period can both be customized. Not At Desk mode can
also be turned off altogether.

See Communicator Preferences > General > Not at Desk mode
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2.12 Online Notification Watch

Online Notification Watch lets you know when another user comes back online.

To add an Online Notification Watch to a user:

1. Locate the user in the User Tree. The user can be in "Not At Desk" mode, "AutoReply" mode or
even completely logged off. Right click on the user's name.

2. Select "Add Online Notification Watch" then left click. See figure 13a.

= Favontes
—- O My Zone [Action Point Softy
+ - o David Jeffreys
+-0 iy .0 Kobayashi
Add COnline Motification Watch
= _O&j Add ko Favarites
+ e Timn Mar
+ 58 My Site [0 Collapse all Children
iy Groups M
Figure 13a

3. When the user comes back online, a notification will appear on your computer desktop. An audible
alert will sound. The Communicator interface pops up with the user already selected to send a
message to. See figure 13b.

jr} Communicator Online Motification

John Savage turned off AutoReply at 'Desk!,

5 Microsoft ... = @ EES Communi.. . % Lo \} 1:55 PM
Figure 13b
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To remove an Online Notification Watch from a user:
1. Locate the user in the User Tree. Right click on the user's name.

2. Select "Remove Online Notification Watch" then left click. See figure 13c.

2 Favorites
-2 My Zone [Action Point Softy
o i David Jeffreps
+-0 i D Kobayashi
SReP*. | ohi Savang
—-Olg Desk
. _D%J ';':"T &dd ta Favorites
+- g Tirn b artin
+- 54 My Site [Data  Collapse all Children

- Groups M
Figure 13c

Femowve Online Matification Wakch

Note: If you exit Communicator or shut down your computer, all Online Notification Watches will be
removed.
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2.13 Add To Favorites

The Add To Favorites feature allows you to list recipients in the Favorites section of your User Tree.
This makes locating frequently contacted users quicker and easier.

To add a user to Favorites:

1. Locate the user in the User Tree. Right click on the user's name.

2. Select "Add to Favorites” then left click. See figure 14a.

2 Favorites
=0y My Zone [Action Point Softy
+ g David Jeffreps
+-0 g J.0. Kobaypashi
=Na) a
S0y Degl  Add Online Motification Watch
oS
+ e Tin Marl
+-- 5 My Site [O)  Callapse all Children
iy Groups |'|

Figure 14a

add to Favorites

3. The user "John Savage" has now been added to the Favorites section of the User Tree.
See figure 14b.

-2 Favorites
-0 John Savage
- Desk
28 Communicatar
-0 My Zone [Action Point 5ofty
+ o David Jeffreps
+-0 g J.0. Kobayashi
— -0 John Savage
-y Desk
28 Communicatar
+ o Tirn Martin
+-- 5 My Site [Datamate]
- iy Groups

Figure 14b

Note: Users can also be "dragged and dropped" into the Favorites section. Left click on the username,
drag it on top of Favorites then release.
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To remove a user from Favorites:

1. Locate the user in Favorites. Right click on the user's name.

2. Select "Remove from Favorites" then left click. See figure 14c.

-l-2 Favorites |
=0 & N
-0 Desk
O'Q B [emave from Favarites
=y My Zone [A
+ i DavidJeffl  Collapse all Children
+-0 % .0 Kobayashi T
-0 % John Savage
-0 Desk
O52% Carnmunicatar
+ - s Tim Martin
+-- g My Site [Datamate]
- i Groups

Figure 14c

Add Online Maotificakion \Wakch

Note: This does not delete the user. The user is simply removed from the Favorites section. The user

can still be located within their normal zone.

In addition to users, applications (Communicator, Email, SMSPager), locations (Desk, Home,

etc.), groups and zones can be added to Favorites.
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2.14 Groups
The Group feature allows you to create customized lists of recipients.

To create a group:

1. Go to File > Advanced User Tree to display the Proxy Tree. See figure 15a.

@ EBS Proxy F§|

Main

Favorites
- g Mr Zone (Action Point Software)
--;- David Jeffreys
;- 1.0 Kobayashi
;- Jobn Savage
;- Tim Markin
-5 My Site (Datamate)
a Groups
- Other Sites

+ -] [F] [

Figure 15a

2. Locate "Groups" in the Proxy Tree. Right click on "Groups" then select "New Group".
See figure 15b.

+ - b John Savage
+ - o Tirn Matkin
+-- g% My Site (Datamate)

Figure 15b

3. In the Create New Group window, enter a name for the group. Click "OK". See figure 15c.
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Create New Group @

Group Mame

| Software Engineering|

Group Tvpe

* Private
~
~

| Allow sends to non-addressable users

K | Cancel

Figure 15c

The new group will now appear in the Groups section of your User Tree.

Note: By default, the group type will be "Private". This means that only you will be able to see the
group. Your network administrator may allow you to create "Public" and "Zone Public" groups. These
can be seen by everyone (Public) or everyone within the same zone (Zone Public).

To add a user to a group:

1. Locate the user in the Proxy Tree. Right click on the user's name.

2. Select "Add to Group". If there is more than one group, select the group then left click.
See figure 15d.

=
T * mdd ko Favorites [ _:
+ e Tim Mar . - — = =
4§k My Site (L &dd ko Group Saofbwate Enginesting [
+- i Groups =
-3 Other Sites
Figure 15d

3. Click "Close" (X) on the Proxy window when you are finished adding users.

Important: Do not select Main > "Exit" when attempting to close the Proxy. This will shutdown the
Proxy and you will be disconnected from the IMiN network.
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To remove a user from a group:
1. From the Proxy Tree, locate the user inside the group. Right click on the user's name.
2. Select "Remove from this Group" then left click. See figure 15e.

+- &g My Site {(Datamate)
iy

i 5:
- a Software Engineering (Private)
m

e +l];.|.1- EM'I: Add ko Favorites
a erote addto Group k

Remove From this Group

Figure 15e

In addition to users, applications (Communicator, Email, SMSPager), locations (Desk, Home,
etc.), zones and even other groups can be added to a group.

To delete a group:
1. In the Proxy Tree, locate the group. Right click on the group name.
2. Select "Delete" then left click. See figure 15f.

+-- §g My Site {(Datamate)

— a ._E oups:

+--

-3 Other Site  Add to Favorites

Madify

Figure 15f
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2.15 Communicator Preferences

2.15.1 General

Communicatar, Preferences

Genetal | Delivery & Status Motifications ] Audio ] Fast Kews ] Skins ] Message Display ]

General
v Start Minimized v Close Buttan also Clears
[v &uka Minimize after Sending [ Simple World Tree Maode
[ Auto Stark [v Unread Messages disable Close
[ Enter Key Sends [ Stay in Taskbar on Minimize
Message Motification Default Recipient
v futo Maximize on Receive [ Mone  Last £ Fixed
Fixed Recipient:
[ Mokify with Balloon Tip | J
Duration (10 -3 30 sec) _|:|

Defaulk Message Format
[ Auto Advance to next Message ™ Bald ™ Italics | Undetline

Delay (5 -= 300 sec) _|:| color: _ e

In Auto Reply Mode
[v Mok A Desk mode

Inactivity period {min): | 15 _I;I
Delay before send (sech; | 10 _|:|

| MoSounds W Mo Auto Advance
[ MoMaximize | Mo Balloon Tip

Cne-touch Maximize Message:

v ctl + 1 alk + b shift + gorry, 1 am nak at my desk right
M,

|.ﬁ.rr-:|w up ﬂ

Ik | Cancel
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General
fitem IDescription IDefault
Always on Top IAIways leaves the message window in the forefront of the screen. v
24 Hour Times ITimes are in military form ex: 16:00 = 4:00pm.
Auto Start Communicator will automatically startup when Windows starts. If

this is not checked, Communicator can be started by going to the

IMiN program group.
JEnter Key Sends llows you to send a message by hitting the Enter key rather than

having_; to click the Send button.
Start Minimized Communicator starts with the Communicator icon in the System v

Tray.
Auto Minimize Message window will automatically minimize after a message is v
after Sending sent. This is the opposite behavior of public IM systems that

presume a person will be spending much of their time sending

messages. The default behavior of Communicator is to get out of

our way so you can do other work. If this is unchecked,

Communicator will remain maximized.
Unread messages [If there is more than one unread message, hitting Close or v
disable Close Escape will advance to the next unread message until all

messages are read.
Stay in Taskbar on Minimizing Communicator (clicking on Close or Minimize, hitting
Minimize the Escape key) sends the program to the Taskbar.

v

Clears the following areas:
Recipient
Outgoing message area
Incoming message area
Un-checking this will retain the current contents. This only affects
the behavior of the Close button and not the File > Hide option

Close Button also By default, clicking the Close button on the Toolbar also clears
(that always clears).

Simple World Tree By default, each user is shown once with the option to expand to
IMode show multiple locations\applications.

+-1U gy EHE Lhang
=0 JO Kobayazhi
-8 Desk
24 Communicatar
(=1 Email

- A effreu lark zon

Checking this option gives a simplified display of one item per
user\location\application which cannot be expanded.

Uit JENE Lhang

L2 D KobapashiComnmunicator
O JD KobapashiEmail

CEE lafireu | ark snnh D esk ACAmer

Note: This does not affect the display of the File > Show Proxy
Tree option.
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Message Notification

Iltem IDescription IDefault
uto Maximize on JCommunicator automatically expands when a new message is v
Receive received. If you find this behavior too disruptive, un-checking this

ill only play a notification sound and cause the Communicator
icon in the System Tray to start flickering to get your attention.
I

The notification of new message is shown with a balloon tip that

INotify with Balloon

Tip lasts a specified number of seconds.
New Communicator Message
Mew Message From
"Alex Agustin',
Tokal number of unread messages: 1
™,
= —
Bl@OoasnveY
Auto Advance to utomatically advances to your next incoming message in the
Inext Message indow after waiting a specified number of seconds. By default, if
multiple messages are received, you have to take action after the
first message to view the second. If this option is checked, the
second message will automatically appear. The previous can still
be viewed in history. This can be useful if you tend to receive a lot
of messages and don't respond to each one.
_

In Auto Reply Mode

Note: This area only disables selected forms of notification while you are in AutoReply mode. Items in
this area will not enable a option that is disabled in another area. For example, if sound is disabled for
incoming messages, you cannot turn it on by un-checking the "No Sounds" box. If sound is enabled

for incoming messages, you can disable it while in AutoReply mode by checking the "No Sounds" box.

Iltem IDescription IDefault
No Sounds By default, you'll hear a sound when you receive a message while

ou're in AutoReply mode. If you don't want to be bothered by that,

check this item.

No Maximize If incoming messages are normally maximized when "Auto v
Maximize on Receive" is checked, you can disable it by checking
his box. Un-check this item if you want to see the text of incoming
messages. If you're not maximizing incoming messages, this box
has no effect.

No Auto Advance ‘If "Auto Advance" is checked, it can be disabled by checking this v

box. If you're not auto advancing to the next message, this box has
no effect.

‘No Balloon Tip ‘If "Notify with Balloon Tip" is checked, the balloon message can be

disable by checking this box. If you're not getting balloon tips, this
box has no effect.

One-touch Maximize
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The default setting is shown below. Pressing Ctrl + Shift + up arrow will maximum Communicator. This
can be customized to any key combination you wish. This is identical to doing the following:

Left-clicking on the Communicator icon in the system tray
Right-clicking on the Communicator icon in the system tray and selecting Show

IKey \Value
ICtrI + v

IAIt +

IShift + v
IKeystroke Arrow up

Default Recipient

This controls the assumptions Communicator will make as to who you want to send a new message
to. The None option requires you to always specify the recipient. The other two options both assume a
specific individual.

Iltem IDescription IDefault

None Check this if you always want to select the recipient of each new
message.

Last Check this if you want the default recipient of each new message v
to be the last person you received a message from. This is good
for continuing conversations with the same person.

Fixed Check this if you want a specific person to be the default for each
new message. This is useful for people who typically
communicate with a single person, such as their boss. The drop-
down list is activated if you check this option.

Default Message Format

These settings allow you to change the default text fomat of your outgoing messages.

Iltem IDescription IDefault
IBoId IPIaces text in bold.

Iltalics IPIaces text in italics.

IUnderIine IUnderIines text.

ICoIor ICoIors text. [Black
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Not At Desk Mode

Communicator keeps track of activity on your computer. If it senses that you are away from your desk,
it can respond to an incoming message to say that you are away from your desk. Think of this as an
automatic "AutoReply" option.

Note: When AutoReply is turned on, it overrides the Not At Desk mode.

Iltem IDescription IDefault

Not At Desk mode [if this is checked, the message listed below will be sent as an v
automatic response if your mouse & keyboard are inactive for the
specified number of minutes. Note: Manually putting yourself in

utoReply mode will override this.

Inactivity period If there is no keyboard activity for this number of minutes, you will 15
(min) be considered away from your desk.
Max=480]
(8 hours)
Min=5
Delay before send [if the inactivity limit above has been exceeded, the message in 10

(sec) the box below will be returned to the sender when a new
message arrives. This controls how quickly your response is sent.] Max=60

The delay is to give you an opportunity to respond if you are near | Min=1
our desk.
Message This is the message that will be sent in response to any incoming jSorry...
message.
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2.15.2 Delivery & Status Notifications

Communicator Preferences E E|
Gereral  Delivery & Status Natifications l.ﬁ.udin:n ] Fast Keys ] Skins ] Message Display ]

IJser Status Monikaring |+ Enable Delivery Reparts

[v Display Status Changes in the Skatus Bari

[ Maotify of Partial Failures
AukoReply /Mot Ak Desk Receipt

Ask me whether to place an
automatic Online Motification WWakch

Iv Mokify with Sodio

[v* Mokify with Balloon Tip

v Eftq:h?ltj ‘:-.?dtaﬁ orline Duration (10 - 30 sec) | 10 _|:|
CHTIESHEn ke [v Display Detailed Repart

Cnline Motifications

[v Only Report Failed Destinations
v Makify with Balloon Tip

[ Resolve Unknown Report Destinations
Duration (10 -= 30 sec) | 10 _|:|
[ Balloon click initiakes Reply

v Makify with Audio

v Initiate a Repl

(04 | Cancel

User Status Monitoring

Iltem IDescription IDefault
Display Status ChangesjShows status changes when any Communicator on your v
in the Status Bar

network changes status. Example: When a user turns off
utoReply, the following will be displayed:

|.-‘-‘-.Ie:-: Agustin turned off AutoBeply.
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AutoReply/ Not at Desk Receipt

Iltem IDescription

IDefault

place an automatic fanother user, Communicator can automatically place an Online
Online Notification JNotification Watch on the user for you.
atch

sk me whether to IWhen you receive an AutoReply or Not At Desk message from
a

hen this option is checked, Communicator will display the
following notification asking whether you want to place this watch:

© Communicator - AutoReply Notification

Alex Agustin is in AutoReply mode,
Do wou wish ko be notified when they burn off ButoReply?

[ Remember my selection

hen this option is unchecked, you will not see this notification.

Note: Checking the "Remember my selection" box has the same
effect as un-checking this option.

v

By default, add an  JThis option only has an effect if "Ask me whether to place an
Online Notification fJautomatic Online Notification Watch" is unchecked. When this is
atch the case and "By default, add an Online Notification Watch" is
checked, an Online Notification Watch is always automatically
added. If this is unchecked, an Online Notification Watch is never
automatically added.

© 2005 - R.B.Zack & Associates, Inc.




IMiN Communicator 41

Online Notifications

If you asked to be notified when a person comes back online, this area determines exactly how you
will be notified. The default settings notify you in the most intrusive manner possible. These can be
modified to something much less intrusive, or removed completely if you are not interested in
receiving naotification that someone has come back online.

Iltem IDescription [Default

INotify with Balloon Tip his will tell you the person is back online with a balloon tip. v

@ Communicator Online Motification
Ales Agustin kurned of F AukoReply,

™,
VIS @HBa Y

Duration (10 -> 30 sec) jif the box above is checked, this setting determines how long 10
he balloon tip will stay at the bottom of the screen. If the box
below is checked to initiate a reply when you click on the
balloon, you should probably increase this setting to give you
more time to respond.

Balloon click initiates Clicking on the balloon will pop-up Communicator to initiate a

Reply reply to the person. If you check this box, you should probably
un-check the "Initiate a Reply" box below. If that box is
checked, Communicator will have already popped up.

Notify with Audio ‘Notify that the person is back online with the sound defined in v

"Watched Entity Online" on the Audio page. Checking only this
option is the least intrusive way of being_] notified.

Initiate a Reply Communicator will pop-up on your screen ready to send a v
response to the person who just came back online.

Enable Delivery Reports

The default behavior of Communicator is to display the delivery results of your outgoing messages in
the status area. Normally, after a message is sent, you should see:

|Deliver_u successful.

If you are sending a message to a number of people, such as everyone in your "Favorites" list, some
of them may not be available. In that case, you see that the delivery was only partially successful.

|Deli'-.fer_l,l partially zucceeded [1 of 3],

If the message could not be delivered to any of the recipients, you see that it failed.

|Deliver_u failed.

Disabling this option will display nothing as to whether your message was delivered or not. The default
"Ready" status will be retained.

|F{ead_l,l
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Note: It is recommended that you leave this option enabled.

Iltem IDescription

IDefault

INotify of Partial Failures JA "partial failure" occurs when you send a message to more
han one recipient but some of the recipients do not receive
he message. This option determines whether you are notified

of partial failures. If this is unchecked, you will only be notified

of a failure when no one receives your message. Example of a
partial failure notification using a balloon tip:

-

@ Communicator Delivery Report

Delivery partially succeeded (1 af 4],

1: Favorites_Steve Bochman,
1: Glenn Zack)DeskiCommunicator Failed,
2 ConfRooml J\DeskhCommunicator Failed,
31 Glenn ZackiLaptoph Cammunicatar Failed,

k N
Ell o B OMOS VY

Notify with Audio Notify of delivery failures with the sound specified in v
Communicator Preferences > Audio > Message Delivery
Failure.

Notify with Balloon Tip [Notify of delivery failures with a balloon tip at the bottom of the v
screen.

Duration (10 -> 30 sec) [The length of time the balloon tip will display at the bottom of 10
he screen.

Display Detailed Report jDetermines whether the delivery report should include the 4
details of the message destinations.

v

Destinations destinations that failed. If this is unchecked, successful

Only Report Failed Determines whether the report should only list those
destinations will also be listed in the report.

Resolve Unknown dvanced feature. Leave box unchecked.
Report Destinations
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If delivery reports are enabled, they are always stored with each message in your history. This can be
viewed by going into History, double-clicking on a message, then clicking the Delivery Report button.

© MM Communicator - JO Kobayas hi

Fres Space  Comments

x| Dieection |Serk snd Receved | Tine | This Wieek

Lecation | This koc ation

EC ® Conversation View - 1 Message

e jEa
o sk
Lr By [ [y ron Tirn Martind ekl Commauricston @ B114:0 L &M (6 11S{2005) M
£ =] ot Dek B Tz 20 Kby sehil Comemnic stor
e Ded 2
& LI M =y (W= D 2
[ ol Back I A Ul e pem 1
r L .| P Delivery Repart
Dtails

axcessul.
15 10 EcheyashiiDeskiCommuncator succeedsd |
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2.15.3 Audio

Communicator Preferences

First Message Received

General ] Delivery & Status Motifications  Audio lFast Kews ] Skins ] Message Display ]

|Su:nunu:|s'l,BuhI:nIe.wav

i

| PC Speaker

Subsequent Messages Received

Browse, ..

Test

v way audio |S-:uunu:|s'l,Tinklel.wav

i

[ PC Speaker

:

Message Delivery Failure

| Repeat Audio Message Received Matification until all messages are read

—

Erowse, ..

Test

dfdi

[v Sy Audio |5-:uunu:|s'l,FaiI.wav

|

[ PC Speaker

Watched Entity Online

Browse, ..

Test

v Wiy Audio |5-:uunds'l,chim32.wav

[ PC Speaker

|

Browse, ..

Test

]

Cancel

| e

This section allows you to control what sound you hear for various events. By default, sounds are
enabled for all four Communicator events. If you want Communicator to work silently, uncheck all of

the WAV Audio and PC Speaker boxes.
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Iltem IDescription
AV Audio ny WAV sound file on your computer can be associated with a
Communicator event.
IBrowse Sound file location. Communicator is distributed with four sound files.

'You can use these or substitute your own.

Open a file...
Look jr: | ) Sounds ﬂ
5 Efbubble, wav:

£ & chimez wav
MyRecent | (@lFail.way
Dacuments C»_‘,':ItinHel i

(4

IPC Speaker

he Advanced button lets you build a custom tune, note by note. This
can be useful if you do not have speakers on your computer and must
rely on the internal PC speaker. Or, if you've got some time on your
hands and a little musical ability, it just might be fun to create your own

© PC Speaker Editor

Mokes
Add Matke Delete Moke

MNotez
Mokes [ Silence
Maoted Pitch  4000Hz |
Duration  S00ms —_}
Test Note Test Tune |

Cancel |
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Communicator events are:

IEvent IDescription

First Message Received[This is the sound you are most likely to hear — the sound of a new
message.

Subsequent Messages JSometimes you may receive messages from multiple people at about

Received he same time. If you receive another message before you are able to
respond to the first message, that second message is referred to as a
'subsequent message". You won't see it until you finish with the current
message, but this sound will let you know it's there.

Message Delivery If Communicator is unable to deliver a message to a recipient, this is the
Failure sound you'll hear.

atched Entity Online hen an Online Notification Watch is triggered by a user coming back
online, this is the sound that will be played.

Repeat Audio Message Received Notification until all messages are read

Iltem IDescription IDefauIt
Repeat every xx Sets the interval in seconds and the number of times the
seconds, xx times... "message received" sound will be repeated until you read the
message or start replying.
_ _
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2.15.4 Fast Keys

Communicator Preferences

General | Delivery & Status Natifications | Audin  Fast Keys ] Skins | Message Display |
" Control Key Set
Key Caption Response Insert Text
G -
R e [w -
| F3 | Take Msg | Take a Massage/Mumber. -
(Fa | will cal | Tl call ight back, -
|F5  |PutThru | Send callthrough. -
| F& | Hald | Aisk ther ta hold, -
|F7  |CallBack | Askthem to call back. r
|Fe  |UHandle | Youhandle please. -
| Fg | Send in | Send them in. -
|F1|;. | About? | What is it about? -
|F11 | ok, | ok, -
|F12 | Lunch? | You gaing ta lunch? =
o | conce

These are user-definable sets of "canned" messages that can be sent with a single keystroke or
mouse click.

Primary Set

This set of Fast Keys is known as the Primary Set.

nl ves |lel  mo |[w] TakeMsy |[m] wilcal |[s| PutThru |l Ho |

| cal Elan:k| - LIHandIe| il Sendin |;1|:| Ahout? |m Ok |;12 Lunch? |

Note: The number of Fast Keys displayed at the bottom of Communicator varies depending on which
skin you are using. Most skins only show the first 12 keys.

Clicking one of these buttons, or hitting function keys F1 through F12 at the top of your keyboard, will
take the text from the Response field and put it into the outgoing message area of Communicator. The
message will be immediately sent to the recipient.
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Checking the Insert Text box...

Key  Capkion Response Insert Texk

| Fi |Linel is on Line 1. v i

...allows you to add additional text to the message before sending it.

ITim b arkinh 0 eskh\Communicatar; Steve iz on Line 1.
O Communicator
;, Temp Admin [15avage]
—|-@ g Tirn Martin
= ConfRaoom

Control Key Set

An additional set of 12 keys is also available. This is known as the Control Key Set.

al  Lined |;2 Line2 |;3 Line3 |;4 Line4 |;5 Lines |FE. Line6 |

| Line? |lml Lined |l Lnes [ Lneto |lm Lrett |l Linetz |

These are identical in functionality to the keys in the Primary Set. If your skin does not display these,
hold down on the Ctrl key to display them. Releasing the Ctrl key returns to the Primary Set. If you
want to use any of them, you must do so while holding the Ctrl key down.
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2.15.5 Skins

Communicator Preferences

General ] Delivery & Status Maokifications ] Audio ] Fast Keys Skins | Message Display ]

Full Skin
Dratate| Like

& skin that will be familiar to Datatel Lite users,

small Skin
Long Win Min

& Min size skin with a windows look Ehat contains

3 Full Fast keys, - ca— T

Change...

(04 Cancel

Skins change the outward appearance of Communicator. The functionality remains the same. In some
cases, some options may disappear or become disabled.

Full Skin

IDataTeI Lite IA skin that will be familiar to DataTel Lite users I

14 full skins are available.

Small Skin

ILong Win Min IA Min size skin with a windows look that contains 3 full fast keys I

3 small skins are available.
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2.15.6 Message Display

Communicator Preferences

General | Delivery & Status Notfications | Audio | Fast Keys | Skins  Message Display |

Incoming Message
Time
B [ Display [ B
Destinations Message
[ Display [ [~ v Formatted | TiHed W Ononew line
Mum Mewlines after Message: 1 _I
Conwversakion
From Time
¥ Display v Titled [ Initials Only W Display | Titled [ Onnew line
Destinations Message
v Display [ Tited [ Initials Only v Formatted W TiHed W Ononew line
Mum Mewlines after each Message: 1 _|:|
Preview
Incoming message, -~
with mulkiple lines,
From: 1D KobayashiyCommunicakor @ 9:40:06 AM (6)29/2005)
To: REZA
Message: message with Formatking,
From: JD KobayashiyCommunicator i 9:40:06 AM (6/29/2005)
To: REZA; Torrance; 1D Kobayashi "

(04 | Cancel

The format of your messages is controlled by the options on this page. The picture above shows the
default settings. This controls the purely cosmetic formatting of the messages. The Preview window at
the bottom of the screen instantly shows the effects of your choices.
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2.16 Keyboard Shortcuts

Keyboard shortcuts enable the majority of Communicator functions to be performed quickly by using a
combination of keys. Shortcuts are ideal for advanced users who want to save time or prefer to use
the mouse as little as possible.

IShortcut IFunction
Ctrl + Shift + Up Arrow Maximize Communicator from the system tray or bring it to the
ront

IESC [Minimize Communicator to the system tray

F1 to F12 and Sends selected Fast Key response as a reply to a message

Ctrl + F1 to F12

Alt + A AutoReply

Alt + C Clears the recipient, sender, incoming and outgoing message
Ivvindows

Alt + F IFind Users

Alt + G IToggIe skin mode

Alt + H IHistory

Alt + M ISets the cursor focus to the outgoing message window

Alt + N ICIears and sets the cursor focus to the recipient window

Alt + P ICommunicator Preferences (Tools)

Alt + S ISend message

Alt + X IDisplays EBS Proxy tree

Alt + Right View next message

Alt + Left View previous message

Alt + ? View "About IMIN Communicator" information

Alt + F4 IExit Communicator
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2.17

Frequently Asked Questions

1. Every time | receive a message, IMiN Communicator pops up on the screen and interrupts
what I'm doing. How can | stop that?

By default, Communicator is set to pop-up when a message is received. To change this, click on the
Tools button. On the General Tab in the Message Notification section, uncheck the "Auto Maximize on
Receive" box.

2. Every time | send a message, the Communicator window disappears. Where does it go and
how do | keep it from disappearing?

By default, the Communicator window is set to minimize to the system tray after sending a message.
To change this, click on the Tools button. On the General Tab in the General section, uncheck the
"Auto Minimize after Sending" box.

3. In a previous version of DataTel, | could send a message to someone when they were off-line
but IMIN Communicator does not allow this.

Communicator uses email to handle off-line messaging. This is an optional feature. Contact your
network administrator to find out if it available at your organization.

4. The Communicator icon disappeared from the system tray. What can | do to bring it back?
By default, Windows XP hides inactive icons. To change this, right click on an empty area in the
Taskbar then select Properties. On the Taskbar tab in the Notification section, either (a) uncheck the
"Hide inactive icons" box or (b) click the "Customize" button, select IMIN Communicator from the
Current Item list then change the behavior to "Always Show".

5. My computer does not have speakers so | don't hear the audible alert when a new message
arrives.

If your computer does not have speakers, Communicator can use the built-in beeper inside your PC.
Click on the Tools button. On the Audio tab, check the "PC Speaker" box for each audible alert.

6. Can IMiN Communicator send file attachments?
No.

7.1 can't bring any other windows to the front when the Communicator window is up. Can |
change this?

Yes. To change this, click on the Tools button. On the General tab in the General section, uncheck the
"Always on Top" box.

8. The icon keeps toggling back and forth between and a single dialog bubble and a double
dialog bubble. What does this mean?

This means you have unread messages. Bring up Communicator and click the message advance
button until all messages have been read.
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